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Preface

1. Scope of this manual:

This manual applies to the FCEN-16UP-M12-Mmodule of ELCO.

The information in this manual enables you to run the FCEN-16UP-M12-M module on Profinet or EtherNet/IP or CC-Link IE

Field Basic as a distributed I/O device.

2. Basic knowledge requirements

This manual presumes a general knowledge in the field of automation engineering and describes the components based

on the data valid at the time of its release.

ELCO reserves the right of including a product information for each new component, and for each component of a later

version.

3. Guide:

This manual introduces the hardware and usage of the FCEN-16UP-M12-M module for the multi-protocol (Profinet &

EtherNet/IP & CC-Link IE Field Basic).

Covered topics are:

 Installation and wiring

 Commissioning and diagnostics

 Components

 Article numbers

 Technical specifications

4. Technical support:

Please contact your local ELCO representative or call the hotline if you have any questions about the products described in

this manual.

Additional information about ELCO products is available:

https://www.elcoautomation.com/en-us/

5. Disclaimer of liability:

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since

variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is

reviewed regularly and any necessary corrections are included in subsequent editions.

https://www.elcoautomation.com/en-us/
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1. Product overview

1.1 Introduction

The FCEN-16UP-M12-M module, which supports switch I/O signals, is a new distributed I/O system with IP67 rating.

This series of products adopts a fully sealed design structure and can be directly installed in industrial sites, including harsh

working environments where liquids, dust, and vibrations may occur.

1.2 Applications

The standard Compact67 I/O module provides a reliable and trustworthy solution for fieldbus I/O systems that connect
controllers and are applied in harsh field environments.
The Compact67 module based on a 60mm wide IP67 protective housing can be installed in a standardized manner and operate
safely and reliably in harsh working environments where water, dust, and vibration may occur. These characteristics make them
suitable for various application scenarios, such as material conveying systems, automated assembly systems, etc.
Other features include support for multiple signal inputs and outputs, and embedded high brightness LED diagnostics to help
maintenance personnel more easily determine I/O, module, and network status.

1.3 Features

 Up to IP67 protection class

 Compact design saves space for direct installation of mechanical equipment

 Fast and reliable connector connection

 Connect multiple input or output switch signals

 LED status display

 Channel protection and diagnosis

1.4 Type

..

No. Type Description

1 FCEN-16UP-M12-M

Multiprotocol (Profinet or EtherNet/IP or CC-Link IE Field Basic) I/O

module

8 Female, M12 A-Code signal ports

2 Male+Female, M12 L-Code power supply

2 Female, M12 D-Code fieldbus interface
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2. Technical characteristics

2.1 Hardware
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2.2 LED indicator

The module's indicator can clearly indicate its operating status. For specific fault indications and solutions, please refer to

Section 7.1 “LED Fault Indicator”.

I/O module indicator

Module statusMOD

System power indicatorUs

EN_In network status LK1

EN_Out network status LK2

Bus comm. statusNET

Digital channel indicatorB

Digital channel indicatorA

Aux. power indicatorUa
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3. Installation and wiring

3.1 Installation dimensions
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3.2 Installation position and size

Thanks to IP67 high protection class and excellent resistance to vibration and interference, FCEN-16UP-M12-M can be installed

in almost any location.

The FCEN-16UP-M12-M module adopts a compact design to maximize installation space savings. The following table shows the

module installation dimensions:

FCEN-16UP-M12-M

Installation width 60 mm

Installation height 230 mm

Installation depth 32.6 mm

3.3 Wiring guidance

Please make sure to cut off power supply when wiring to ensure safety.

3.3.1 Connecting module to protective earth (PE)

 Always connect the module to protective earth.

 The module also requires this connection to protective earth in order to discharge any interference currents to ground,

and for EMC compatibility.

 Always make sure you have a low-impedance connection to protective earth.

3.3.2 Module power supply

FCEN-16UP-M12-M module adopts 24VDC power supply and can supply power to the connected sensors or actuators through

signal connection lines. The input voltage range is 18-30VDC, standard M12 L-Code connector.

The power supply of I/O module is divided into two parts: System and sensor power supply Us (+24V, 0V), and auxiliary power

supply Ua (P24, N24). Us is used for module chips and input signal power supply, while Ua is used for output signal power

supply.

For FCEN-16UP-M12-M, the two power supply are partially isolated, electrical isolation between Us+ and Ua+, and internally

connected between Us- and Ua-.

1）Power in connector (Male)
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2）Power out connector (Female)

3）Power definition

Terminal Function Power supply

1 System and input power supply Us+ 24V

2 Output power supply Ua- 0V

3 System and input power supply Us- 0V

4 Output power supply Ua+ 24V

5 Function earth FE

3.3.3 Module BUS connection

FCEN-16UP-M12-M module, supporting multi-protocol (Profinet and EtherNet/IP and CC-Link IE Field Basic), transmits signals

by a shielded cable, M12 D-Code connector.

1）BUS-In (Female)

2）BUS-Out (Female)

3）Bus definition

Terminal Function Cable color

1 Transmit Data (TD+) Yellow

2 Receive Data (RD+) White

3 Transmit Data (TD-) Orange

4 Receive Data (RD-) Blue
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3.3. 4 I/O signal port cable connection

All Compact67 series I/O signals are connected through standard 5-pin M12 connectors, and each M12 port can connect up to 2

switch signals (input or output).

1）I/O port connector (Female)

2）I/O port pin definition

Terminal Class-A

1 Power supply 24V+

2 Signal input/output B

3 Power supply GND

4 Signal input/output A

5 Protection Earth PE

3）The power supply (Pin1 and Pin3) and signal input power supply come from the system power supply Us, and the

signal output (Pin4 or Pin2) power supply come from the auxiliary power supply Ua.

4）Wiring example

a) Dual input signal - one connector is connected to two switch input signals, the FCEN-16UP-M12-M product

supports this form of connection.

b) Dual output signal - one connector is connected to two switch output signals, the FCEN-16UP-M12-M product

supports this form of connection.
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c) Input and output signals - one connector connected to one digital input and one digital output signal, the

FCEN-16UP-M12-M product supports this form of connection.

3.4 Setting protocols of the module

The multiprotocol technology allows you to use the same module in different fieldbus systems. The FCEN-16UP-M12-Mmodule

supports both Profinet and EtherNet/IP and CC-Link IE Field Basic protocols, users can easily switch them.

The FCEN-16UP-M12-M module can set the protocol and network parameters (such as IP address, subnet mask, etc.) through

its built-in rotary code switch. The module will read the status of the switch and update the corresponding network parameter

operation mode when re-powered on.

Note: Please operate the rotary code switch when the module is powered off, and it will take

effect when powered on again.

The following table describes the protocol selection by the rotary switch settings:

Protocol x100 x10 x1

EtherNet/IP 0-2 0-9 0-9

Profinet 3 0-9 0-9

CC-Link IE FB 4-6 0-9 0-9

The factory default setting of the rotary switch is 300, that means it works as a Profinet slave. You can change the protocol to

EtherNet/IP by setting the rotary switch to 000~299. By setting the rotary switch to 400~699, the protocol can be changed to

CC Link IE FB. If you want to do this, you must turn off the power supply of the module first. After you finish the setting of

rotary switch, power on the module again and the module will start the switching process. The LED next to the rotary switch

will flash yellow. The protocol switching will be finished after about 20 seconds. The LED indicator next to the rotary switch

will turn off. Then you have finish the protocol switching progress after the power recycled.
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If you want to change the protocol back to Profinet. You need to repeat the process above with setting rotary switch to

300-399.

4. EtherNet/IP

4.1 Setting the network parameters

When the FCEN-16UP-M12-M module powered on, the module will read the rotary switch positions. If the rotary switch

position stays 000~299, the module will work in EtherNet/IP protocol.

The module supports the DHCP and BOOTP protocols for receiving the required network parameters such as IP address and

subnet mask.

The default IP settings of EtherNet/IP for the module are:

IP address: 192.168.250.xxx

Subnet Mask: 255.255.255.000

You can change the IP address by DHCP (section 4.1.1) or Webserver (section 4.1.2).

The following table describes the operating modes represented by the rotary code switch settings:

Rotary code switch Function

000

(EtherNet/IP)

Activate DHCP and BOOTP functions.

In this mode, IP addresses can be assigned through specialized

software such as Rockwell's built-in BOOTP-DHCP server and other

tools. Please refer to the example for explanation.

001~254

(EtherNet/IP)

The last three digits of an IP address.

In this mode, network information such as IP addresses can be

modified by accessing the Webserver module through a browser. Only

the first 9 digits can be set, and the last 3 digits are based on the rotary

switch.

If the module has already been assigned an IP address through DHCP

of 000, it needs to be reset using 999 before the IP address in this

mode can take effect.

255~299

(EtherNet/IP)

Illegal address, invalid setting.

The original network parameters of the module will not be changed.
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300~399

(Profinet)

The module runs under the PROFINET protocol and the IP address

needs to be set through programming software (such as Portal).

400~699

(CC-Link IE FB)

This module runs under the CC Link IE Field Basic protocol. Please refer

to the following sections for setting the IP address.

700~998 Reserved multiple protocol switching related functions, please do not

select.

999 Module reset.

This mode needs to be maintained for more than 5 seconds after

power on, and when the module port indicator lights scroll and flash,

it indicates a successful reset.

This operation will clear network parameters such as module IP

address and restore to factory settings. Please operate with caution.

4.1.1 Setting IP through DHCP software (Code: 000)

When the rotary code switch is selected as 000, the FCEN-16UP-M12-M module allocates network parameters such as IP

addresses and subnet masks through DHCP software. This section takes the BOOTP-DHCP server tool that comes with Rockwell

software as an example to demonstrate how to allocate IP addresses.

First open the BOOP-DHCP server, click on Tools->Network Settings to set the network parameters and fill in the Subnet Mask.

Then the DHCP server will find current gateway that has no IP address assigned on the network, and then click the gateway

MAC address that needs to be assigned IP.
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Then click Add to Relation List, or double-click MAC address, in the pop-up window, fill in IP address in IP bar, such as

192.168.1.108.

As follows:

Note: the assigned IP address needs to be in the same IP segment as the local

computer.

After the assigned IP address appears in the IP Address column in the list, the IP address of the device is assigned successfully.

As follows:
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After the IP address is assigned, the device can work normally on the network. However, if the device is powered off and

restarted, the assigned IP address will be lost. Follow the above steps to process IP address allocation. If the IP address to be

distributed is solidified to the gateway and its power-off IP address is not lost, you need to click the Disable BOOTP/DHCP

button in the following figure. After the Command Successful appears in the Status column, the IP address is successfully

solidified. If you click the Status column and there is no success message, you need to click again until the command succeeds.

As follows:

Note: If the module has already been assigned an IP address and BOOTP/DHCP is disabled, it will

not be able to be automatically searched. There are two ways to reset the IP address.

1) You need to click the "New" button, manually add the MAC and original IP address of the module,

and then click the "Enable DHCP" button. Once successful, you can search for this module. Then

close the software and power on the module again to assign a new IP.

2) In the event of a power outage, turn the rotary code back to 999 and then power on again for 5

seconds. Wait for the module port indicator light to scroll and flash, then power off again and

switch back to 000 to reassign.
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4.1.2 Setting IP through Webserver (Code: 001~254)

When the rotary code switch is selected from 001 to 254, the FCEN-16UP-M12-M module accesses the web server through a

browser to allocate network parameters such as IP addresses and subnet masks.

The default value of the module or after resetting through code 999, the default IP address is 192.168.250.xxx (depending on

the rotary switch value). When the computer and module IP addresses are in the same network segment, you can use a

browser to enter http://192.168.250.xxx/webif/ to access the module and modify the first 9 digits of the IP address.

You can see the IP address setting interface on the homepage, modify the values of the IP address and subnet mask, and click

the "Set IP" button.

After successful setup, "IP configuration successful" will display under the button, The prompt "effective after board reboot"

indicates that the new IP address will take effect after the power reboot.

http://192.168.250.xxx/webif
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4.2 Module address assignment

This section mainly introduces the signal point arrangement order and address assignment of the FCEN-16UP-M12-M module,

mainly to indicate the clear sequence of signals. Due to the different addressing methods in different PLC systems, this article

explains them in Bytes, and systems in Word or DWord units can be arranged in the same order.

The FCEN-16UP-M12-M module supports multiple connection types such as Exclusive owner, Input only, Listen only, etc. By

default, the Exclusive owner type that supports input and output signals is used. The data size and instance encoding are shown

in the table below:

Data size Instance ID Length of data

INPUT 101 8 bytes

OUTPUT 100 6 bytes

CONFIG 102 34 bytes

The default connection name is "I/O Connection Point", which includes the input and output signals and status indicators of the

I/O module. There will be detailed descriptions in subsequent chapters.

4.3 INPUT data address assignment

The FCEN-16UP-M module occupies a total of 8 bytes (Bytes 0-7) of input data.

The following table lists the mapping of input data occupied by the I/O module respectively:

INPUT Description

Byte 0 Input Signal Data of Port 0~3

Byte 1 Input Signal Data of Port 4~7

Byte 2 Short Circuit Diagnosis of Port 0~3

Byte 3 Short Circuit Diagnosis of Port 4~7

Byte 4 Overload Diagnosis of Port 0~3

Byte 5 Overload Diagnosis of Port 4~7

Byte 6 Power Supply Diagnosis

Byte 7 Reserved

For a detailed description of the INPUT, please refer to the following text:
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Byte 0~1（Input Signal Data）

This section consists of 2 Bytes, used to represent the state when the signal port is connected to a switch signal.

Byte 0 Digital input status of port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 07 06 05 04 03 02 01 00

Pin Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Port0

Pin2

Port0

Pin4

Byte 1 Digital input status of port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 15 14 13 12 11 10 09 08

Pin Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

Port4

Pin2

Port4

Pin4

Byte 2~3（Short Circuit Diagnosis）

When a short circuit fault occurs between pins Pin1 and Pin3 of the signal port, the corresponding point indicates 1,

otherwise the point indicates 0.

Byte 2 Short Circuit Diagnosis of Port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port3 Port2 Port1 Port0

Byte 3 Short Circuit Diagnosis of Port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port7 Port6 Port5 Port4

Byte 4~5（Overload Diagnosis）

When an overload fault occurs between the signal port pins Pin4/Pin2 and Pin3, the corresponding point indicates 1,

otherwise the point indicates 0.

Byte 4 Overload Diagnosis of Port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Port0

Pin2

Port0

Pin4

Byte 5 Overload Diagnosis of Port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

Port4

Pin2

Port4

Pin4
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Byte 6（Power Supply Diagnosis）

When there is an abnormality in the power supply of the module, according to the fault status of overvoltage and

undervoltage of the voltage value, the corresponding point indication is 1, otherwise the point is 0.

Byte 3 Power Supply Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean Ua_H
High
voltage

Ua_L
Low
voltage

Us_H
High
voltage

Us_L
Low
voltage

Ua_S
Short
circuit

- - -

4.4 OUTPUT data address assignment

The FCEN-16UP-M12-M module occupies a total of 6 bytes (Bytes 0-5) of output data. The following table lists the mapping of

output data occupied by the I/O module respectively:

INPUT Description

Byte 0 Output Signal Data of Port 0~3

Byte 1 Output Signal Data of Port 4~7

Byte 2 Reserved

Byte 3 Reserved

Byte 4 Reserved

Byte 5 Reserved

For a detailed description of the OUTPUT, please refer to the following text:

Byte 0~1（Output Signal Data）

This section consists of 2 Bytes, used to represent the output of the signal port control switch signal.

Byte 0 Digital output status of port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 07 06 05 04 03 02 01 00

Pin Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Port0

Pin2

Port0

Pin4

Byte 1 Digital output status of port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 15 14 13 12 11 10 09 08

Pin Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

Port4

Pin2

Port4

Pin4
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4.5 CONFIG data address assignment

The FCEN-16UP-M12-M module occupies a total of 34 bytes (Bytes 0-33) of config data. The following table lists the mapping of

config data:

CONFIG Description

Byte 0 Process Data Layout

Byte 1…16 Pin4&Pin2 Type of Port 0~7

Byte 17…32 Pin4&Pin2 Safe State of Port 0~7

Byte 33 Signal Filter Setting

For a detailed description of port settings, please refer to the following:

Byte 0（Process Data Layout）

This parameter is used to set the address mapping order of the I/O module switch input and output signals. The default

value is 0, which is arranged by port; It can also be set to 1, which is arranged according to the pins.

0-Port based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port0 Pin4 Port0 Pin4

1 Port0 Pin2 Port0 Pin2

…… …… ……

6 Port3 Pin4 Port3 Pin4

7 Port3 Pin2 Port3 Pin2

X+1 0 Port4 Pin4 Port4 Pin4

1 Port4 Pin2 Port4 Pin2

…… …… ……

6 Port7 Pin4 Port7 Pin4

7 Port7 Pin2 Port7 Pin2

1-Pin based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port0 Pin4 Port0 Pin4

1 Port1 Pin4 Port1 Pin4

…… …… ……

6 Port6 Pin4 Port6 Pin4

7 Port7 Pin4 Port7 Pin4

X+1 0 Port0 Pin2 Port0 Pin2

1 Port1 Pin2 Port1 Pin2

…… …… ……

6 Port6 Pin2 Port6 Pin2

7 Port7 Pin2 Port7 Pin2
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Byte 1…16（Pin4&Pin2 Type）

This section is used to set the properties of Pin4&Pin2 in each port of the I/O module, which can control the I/O function

of the ports.

Each port occupies 2 bytes of data, one is for Pin4 and the other is for Pin2. The default is 3, which means I/O Universal;

Can be set to 0, means INPUT mode; Can be set to 1, means OUTPUT mode.

Byte 1…16 Pin4&Pin2 Type of Port 0~7

Byte 1 Pin4 type of Port 0 (0=DI, 1=DO, 3=I/O Universal)

Byte 2 Pin2 type of Port 0 (0=DI, 1=DO, 3=I/O Universal)

Byte 3 Pin4 type of Port 1 (0=DI, 1=DO, 3=I/O Universal)

Byte 4 Pin2 type of Port 1 (0=DI, 1=DO, 3=I/O Universal)

Byte 5 Pin4 type of Port 2 (0=DI, 1=DO, 3=I/O Universal)

Byte 6 Pin2 type of Port 2 (0=DI, 1=DO, 3=I/O Universal)

Byte 7 Pin4 type of Port 3 (0=DI, 1=DO, 3=I/O Universal)

Byte 8 Pin2 type of Port 3 (0=DI, 1=DO, 3=I/O Universal)

Byte 9 Pin4 type of Port 4 (0=DI, 1=DO, 3=I/O Universal)

Byte 10 Pin2 type of Port 4 (0=DI, 1=DO, 3=I/O Universal)

Byte 11 Pin4 type of Port 5 (0=DI, 1=DO, 3=I/O Universal)

Byte 12 Pin2 type of Port 5 (0=DI, 1=DO, 3=I/O Universal)

Byte 13 Pin4 type of Port 6 (0=DI, 1=DO, 3=I/O Universal)

Byte 14 Pin2 type of Port 6 (0=DI, 1=DO, 3=I/O Universal)

Byte 15 Pin4 type of Port 7 (0=DI, 1=DO, 3=I/O Universal)

Byte 16 Pin2 type of Port 7 (0=DI, 1=DO, 3=I/O Universal)

Byte 17…32（Pin4&Pin2 Safe State）

This section is used to set the safety status of Pin4&Pin2 output in each port of the I/O module. When the I/O module

experiences network disconnection or other abnormalities, the Pin2 output signal will switch to the set value.

Each port occupies 1 bytes of data, which is an SINT variable. The default is 0, which means the output is turned off in

case of an exception; Can be set to 1, which means the output is turned on in case of an exception; It can be set to 2,

which means the output will maintain the last value in case of an exception.

Byte 17…32 Pin4&Pin2 Safe State of Port 0~7

Byte 17 Pin4 safe state of Port 0

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 18 Pin2 safe state of Port 0

(0=SetTo0, 1=SetTo1, 2=HoldLast)
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Byte 19 Pin4 safe state of Port 1

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 20 Pin2 safe state of Port 1

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 21 Pin4 safe state of Port 2

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 22 Pin2 safe state of Port 2

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 23 Pin4 safe state of Port 3

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 24 Pin2 safe state of Port 3

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 25 Pin4 safe state of Port 4

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 26 Pin2 safe state of Port 4

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 27 Pin4 safe state of Port 5

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 28 Pin2 safe state of Port 5

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 29 Pin4 safe state of Port 6

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 30 Pin2 safe state of Port 6

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 31 Pin4 safe state of Port 7

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 32 Pin2 safe state of Port 7

(0=SetTo0, 1=SetTo1, 2=HoldLast)

Byte 33（Signal Filter Setting）

This section is used to set the filtering strength of the signal port. Depending on the setting value, the port will filter the

input switch signal. The smaller the value, the weaker the filtering strength; The larger the value, the stronger the

filtering strength. The default value is 1.

0: extremely weak;

1: weak;
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2: medium;

3: strong;

4: extremely strong

4.6 Configuration commissioning (AB PLC)

4.6.1 Installing EDS files

Use EDS files to configure the EtherNet/IP protocol I/O module, which is used to integrate the EtherNet/IP protocol module as a

standard EtherNet/IP slave into your system. You can visit the ELCO company website to obtain the latest EDS files or call the

customer service hotline to contact technical personnel.

The integration of EDS files into the system depends on the configuration software you are using. Typically, the Rockwell

Studio5000 programming software used for the EtherNet/IP protocol integrates EDS files according to the following steps:

1） Run “Logix Designer” software and select “TOOLS>EDS Hardware Installation Tool” in the menu bar.

2） In the open dialog box, select "Register an EDS file" to proceed to the next step, select the EDS file to be installed,

and then click "Next" to proceed with the installation operation.
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3） The newly installed I/O module can be found when adding network devices and is displayed in the "NewModule"

interface. By filtering the "Module Type Vendor Filter" and selecting "Elco (Tianjin) Electronic", this module can be

found and added in the Catalog.

4.6.2 Configuration example in Logix Designer

This section provides users with a comprehensive understanding of the actual use of the I/O module in the EtherNet/IP protocol

through a configuration connection process. This example uses ELCO's FCEN-16UP-M12-M module as the EtherNet/IP slave to

connect Rockwell's 1756-L71 controller and 1756-EN2TR network adapter. By default, all power supply and bus connections

have been completed.

We show the specific software configuration process in the form of pictures:

1) Create a new Studio5000 project.
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A) Open the “Logix Designer” software and click "File>New...".

B) In the pop-up interface, select the PLC type to use and click "Next".

C) Select PLC version, rack, slot number, etc., and click "Finish".
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2) Add the 1756-EN2TR network module and set the IP address.

A) In the left Controller Organizer navigation bar, right-click on “1756-A4”, select “New Module...”, select

“1756-EN2TR” in the open interface, and click "Create".

B) In the pop-up interface, fill in the IP address 192.168.0.5 of the module and provide the required name for the

module, such as EN2TR. Click "OK" to complete the network adapter configuration.
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3) Add the FCEN-16UP-M12-M module and set the IP address.

A) In the left Controller Organizer navigation bar, right-click on Ethernet under 1756-EN2TR, select "New Module...",

filter ELCO in the open interface, select module model FCEN-16UP-M12-M, and click "Create".

B) In the pop-up interface, fill in the IP address 192.168.0.11 of the module and provide the required name for the

module, such as “CP67_M”. Click "OK" to complete the configuration of the I/O module.
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4) After completing the configuration of the hardware module, it is necessary to map the ports and other parameters of the I/O

module. You can refer to Section 4.5 for the allocation of data addresses. The default signal type for each port is “I/O Universal”

mode, and the safe state for the output is “Set-0”, which can be set as needed.

Note: If the value of the CONFIG parameter is modified after network connection, the I/O

module must be re-powered on or connected back to the network in order for the newly

modified parameters to take effect.

5) Select the already set connection in the RSlinx Classic. In this example, connect through the AB_ETHIP network and select

the "Go Online" button to switch the software to online mode. At the same time, a pop-up interface will pop up and select

"Download" to download the program to the PLC.
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6) After completing the download operation, the NET light of FCEN-16UP-M12-M module will turn green, indicating that the

EtherNet/IP connection between the module and the PLC is successful. The input and output signals of the control module can

be read and controlled through the Controller Tags variable table or by programming.

7) All configuration work has been completed and can be used normally.

5. PROFINET

5.1 Setting the network parameters

When the FCEN-16UP-M12-M module powered on, the module will read the rotary switch positions. If the rotary switch

position stays 300~399, the module will work in PROFINET protocol.

The factory default IP address is 0.0.0.0 and the default device name is empty. You can set them by the Siemens programming

software Portal.

1） Run “TIA Portal” software and select “Project view” in the left side.
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2） In the new window, Click "Online Access" in the "Project Tree" on the left, finding the name of the computer

network card. Double-click "Update accessible devices" and then the name and MAC address of the connected I/O

module will be scanned.

3） Double click the module you scanned, open the “Online & diagnostics” tab. Under the “Functions”, you can assign

IP address and PROFINET device name to the module.

1）The “device name” will be used in the programming steps.

2）The “IP address” can be used for accessing the Webserver.
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5.2 Module address assignment

This section mainly introduces the signal point arrangement order and address assignment of the FCEN-16UP-M12-M module,

mainly to indicate the clear sequence of signals. This picture shows the I/O signal and status of the I/O module:

5.2.1 I/O signal of the module

This section consists of 2 bytes, used to represent the status of the I/O module when receiving and controlling switch signals.

The default order of port signals is Port base, which means that the mapping addresses are arranged in port order. First, Pin4 of

the first port is arranged, then Pin2 of the first port, then Pin4 of the second port, and so on.

Byte 0 Digital input/output status of port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 07 06 05 04 03 02 01 00

Pin Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Port0

Pin2

Port0

Pin4

Byte 1 Digital input/output status of port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 15 14 13 12 11 10 09 08

Pin Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

Port4

Pin2

Port4

Pin4

5.2.2 Status feedback of the module

This section consists of 4 bytes, used to represent the status and error information related to the I/O module. Users can freely

choose to configure any item.

INPUT Description

Byte 2 Overload Diagnosis of Port 0~3

Byte 3 Overload Diagnosis of Port 4~7

Byte 4 Power Supply Diagnosis

Byte 5 Short Circuit Diagnosis of Port 0~7
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For a detailed description of status feedback, please refer to the following:

Byte 2~3（Overload Diagnosis）

When an overload fault occurs between the signal port pins Pin4/Pin2 and Pin3, the corresponding point indicates 1,

otherwise the point indicates 0.

Byte 2 Overload Diagnosis of Port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Port0

Pin2

Port0

Pin4

Byte 3 Overload Diagnosis of Port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

Port4

Pin2

Port4

Pin4

Byte 4（Power Supply Diagnosis）

When there is an abnormality in the power supply of the module, according to the fault status of overvoltage and

undervoltage of the voltage value, the corresponding point indication is 1, otherwise the point is 0.

Byte 4 Power Supply Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean Ua_H
High
voltage

Ua_L
Low
voltage

Us_H
High
voltage

Us_L
Low
voltage

Ua_S
Short
circuit

- - -

Byte 5（Short Circuit Diagnosis）

When a short circuit fault occurs between pins Pin1 and Pin3 of the signal port, the corresponding point indicates 1,

otherwise the point indicates 0.

Byte 5 Short Circuit Diagnosis of Port 0~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port7 Port6 Port5 Port4 Port3 Port2 Port1 Port0
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5.3 Setting parameters of the module

Users can set the parameters of the module in TIA Portal. Enter the "Device View" interface and select "Properties-> General->

Module Parameters" of "16UP_1". Users can modify the module parameters as needed.

5.3.1 Signal Filter Settings

This section is used to set the filtering strength of the signal port. Depending on the setting value, the port will filter the input

switch signal. The smaller the value, the weaker the filtering strength; The larger the value, the stronger the filtering strength.

The default value is 1.

0: extremely weak;

1: weak;

2: medium;

3: strong;

4: extremely strong

5.3.2 Process Data Layout

This parameter is used to set the address mapping order of the I/O module switch input and output signals. The default value is

0, which is arranged by port; It can also be set to 1, which is arranged according to the pins.
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0-Port based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port0 Pin4 Port0 Pin4

1 Port0 Pin2 Port0 Pin2

……

6 Port3 Pin4 Port3 Pin4

7 Port3 Pin2 Port3 Pin2

X+1 0 Port4 Pin4 Port4 Pin4

1 Port4 Pin2 Port4 Pin2

……

6 Port7 Pin4 Port7 Pin4

7 Port7 Pin2 Port7 Pin2

1-Pin based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port0 Pin4 Port0 Pin4

1 Port1 Pin4 Port1 Pin4

……

6 Port6 Pin4 Port6 Pin4

7 Port7 Pin4 Port7 Pin4

X+1 0 Port0 Pin2 Port0 Pin2

1 Port1 Pin2 Port1 Pin2

……

6 Port6 Pin2 Port6 Pin2

7 Port7 Pin2 Port7 Pin2

5.3.3 Port settings of the module

This section used to set the function of the I/O module ports Pin4/Pin2, and the status of Pin4/Pin2 output in case of network

disconnection or other abnormalities.

For a detailed description of port settings, please refer to the following:

Item_1（Port Direction of Port 0~7）

This section is used to set the properties of Pin4/Pin2 in each port of the I/O module, which can be set as input or

output or universal.

The default is “I/O Universal”, which means the Pin4/Pin2 can be used as Input or Output by wiring; Can be set to

“Input”, which means only as Input; Can be set to “Output”, which means only as Output.
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Item_2（Safe state of Port 0~7）

This section is used to set the safety status of Pin4/Pin2 output in each port of the I/O module. When the I/O module

experiences network disconnection or other abnormalities, the output signal will switch to the set value.

The default is “Set to 0”, which means the output is turned off in case of an exception; Can be set to “Set to 1”, which

means the output is turned on in case of an exception; Can be set to “Hold the last value”, which means the output will

maintain the last value in case of an exception.
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5.4 Module configuration by Portal (Siemens PLC)

This section, through a case of connection configuration in a current operation process, will let the users fully understand how

to use the FCEN-16UP-M12-Mmodule. In this case, using the FCEN-16UP-M12-M as PROFINET slave to connect the Siemens

controller CPU1511 under the condition that all power and bus connections have been completed, the device name of I/O

module is assigned as CP67.

The following will show the specific process of software configuration and debugging.

1）Create a new Portal project

Open Portal software, click "Create New Project", change "Project Name" to "example", select the save path, and click

"Create".

2）Install GSD files for the FCEN-16UP-M12-Mmodule.

a）Select "Options"->"Manage General Station Description File (GSD)" in the menu bar, click to open a new window.
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b）Select the version of the GSD file to be imported and click “Install”.

3）Double-click "Add New Device" on the left and select the PLC model in the "Controller" window.
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4）Double-click the "Device Configuration" window on the left, and in the "Network View" window, select

"Properties"->"PROFINET Interface [X1]" -> "Ethernet Address" and set the IP address of the PLC.

5）Add FCEN-16UP-M12-M module and communicate with PLC

a）Double-click "Devices & Networks" on the left to enter the "Network View" interface and select

FCPN-16UP-M12-M through "Other Field Devices-> PROFINET IO-> I / O-> ELCO-> FCEN" in "Hardware Catalog",

double-click or drag to add to the network.
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b）Click the "Not assigned" hyperlink and click to select “PLC_1.PROFINET Interface_1”

c）The FCEN-16UP-M12-M and PLC complete communication connection.
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6）Modify the device name and IP address settings of the I/O module

a）Click the FCEN-16UP-M12-Mmodule in the "Network View", select "Properties-> PROFINET Interface-> Ethernet

Addresses", set the I/O module device name “CP67” in the window.

b）Click "Online Access" in the "Project Tree" on the left, find the name of the upper computer network card,

double-click "Update accessible devices", and then the name and MAC address of the connected FCEN-16UP-M12-M

module will be scanned. Double-click " Online and Diagnostics ", modify the device name to “CP67” in this interface.

Note: The name of the module must be the same as the device name modified in the previous step.
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7）The FCEN-16UP-M12-M module has a total of 16 switch signal points, which can be used as inputs or outputs as

needed. After configuration, it can be seen that the default allocation is 2 bytes for input and 2 bytes for output, which

are used to represent the status of input and output signals.

8）Users can add diagnostic modules to the last 3 slots to read module status and diagnostic process data. You can

double-click or drag the diagnostic module to the corresponding slot. For specific instructions on the status, please refer

to section 5.2.2.
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9）After saving and compiling, download the configuration to the PLC.

10）When the NET indicator light of FCEN-16UP-M12-M module is constantly green, the configuration is successful.

6. CC-Link IE Field Basic

6.1 Setting the network parameters

When the FCEN-16UP-M12-M module powered on, the module will read the rotary switch positions. If the rotary switch

position stays 400~699, the module will work in CC-Link IE Field Basic protocol.

The module supports the DHCP and BOOTP protocols for receiving the required network parameters such as IP address and

subnet mask.

The default IP settings of CC-Link IE Field Basic for the module are:

IP address: 192.168.3.xxx

Subnet Mask: 255.255.255.000

You can change the IP address by setting the rotary code switch or the web server.

The following table describes the operating modes represented by the rotary code switch settings:

Rotary code switch Function

000~299

(EtherNet/IP)

This module runs under the EtherNet/IP protocol. Please refer to the

previous section for setting the IP address.

300~399

(Profinet)

This module runs under the PROFINET protocol. Please refer to the

previous section for setting the IP address.
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401~654

(CC-Link IE FB)

Subtract 400 from the value to obtain the last three digits of the IP

address. (i.e. 1-254)

In this mode, the Webserver module can be accessed through a

browser to modify network information such as IP addresses. Only the

first 9 digits can be set, and the last 3 digits are subject to the rotation

code.

Do not set the address to 400, otherwise the IP address may not be

successfully set.

655~699

(CC-Link IE FB)

Illegal address, invalid setting.

The original network parameters of the module will not be changed.

700~998 Reserved multiple protocol switching related functions, please do not

select.

999 Module reset.

This mode needs to be maintained for more than 5 seconds after

power on, and when the module port indicator lights scroll and flash,

it indicates a successful reset.

This operation will clear network parameters such as module IP

address and restore to factory settings. Please operate with caution.

When the rotary code switch is selected as 401~654, subtracting 400 from this value will result in the last 3 bits of the module

IP address being 1~254. Meanwhile, the FCEN-16UP-M12-Mmodule can access the Webserver through a browser to allocate

network parameters such as IP addresses and subnet masks.

The default value of the module or after resetting through code 999, the default IP address is 192.168.3.xxx (depending on the

rotary switch value minus 400). When the computer and module IP addresses are in the same network segment, you can use a

browser to enter http://192.168.3.xxx/webif/ to access the module and modify the first 9 digits of the IP address.

http://192.168.3.xxx/webif
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You can see the IP address setting interface on the homepage, modify the values of the IP address and subnet mask, and click

the "Set IP" button.

After successful setup, "IP configuration successful" will display under the button, The prompt "effective after board reboot"

indicates that the new IP address will take effect after the power reboot.

6.2 Module address assignment

This section mainly introduces the signal point arrangement order and address allocation of the FCEN-16UP-M12-M module,

which is used to clarify the signal arrangement order. This figure shows the occupancy information of software components in

the FCEN module:

6.2.1 I/O signal of the module

2 bytes each for input and output, used to represent the I/O module port receiving or controlling switch signals

The default order of port signals is Port base, which means that the mapping addresses are arranged in port order. First, Pin4 of

the first port is arranged, then Pin2 of the first port, then Pin4 of the second port, and so on.
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RX/RY 0 Digital input/output status of port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 07 06 05 04 03 02 01 00

Pin Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Port0

Pin2

Port0

Pin4

RX/RY 1 Digital input/output status of port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 15 14 13 12 11 10 09 08

Pin Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

Port4

Pin2

Port4

Pin4

6.2.2 Status feedback of the module

This section occupies the RWr area of the module, consisting of 4 words, used to represent the status and error information

related to the I/O module. Users can freely choose whether to use this part of the content according to their needs.

INPUT Description

RWr 0 Short Circuit Diagnosis of Port 0~7

RWr 1 Overload Diagnosis of Port 0~3

RWr 2 Overload Diagnosis of Port 4~7

RWr 3 Power Supply Diagnosis

For a detailed description of status feedback, please refer to the following:

RWr 0（Short Circuit Diagnosis）

This section consists of 1 word. When a short circuit fault occurs between pins Pin1 and Pin3 of the signal port, the

corresponding point indicates 1. Otherwise, the point indicates 0.

RWr 0 Short Circuit Diagnosis of Port 0~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Port7 Port6 Port5 Port4 Port3 Port2 Port1 Port0

RWr 0 Reserved

Bit Bit_15 Bit_14 Bit_13 Bit_12 Bit_11 Bit_10 Bit_9 Bit_8

Pin - - - - - - - -

RWr 1（Overload Diagnosis of Port 0~3）

This section consists of 1 word. When an overload fault occurs between the signal port pins Pin4/Pin2 and Pin3, the

corresponding point indicates 1, otherwise the point indicates 0.
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RWr 1 Overload Diagnosis of Port 0~3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Port0

Pin2

Port0

Pin4

RWr 1 Reserved

Bit Bit_15 Bit_14 Bit_13 Bit_12 Bit_11 Bit_10 Bit_9 Bit_8

Pin - - - - - - - -

RWr 2（Overload Diagnosis of Port 4~7）

This section consists of 1 word. When an overload fault occurs between the signal port pins Pin4/Pin2 and Pin3, the

corresponding point indicates 1, otherwise the point indicates 0.

RWr 2 Overload Diagnosis of Port 4~7

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

Port4

Pin2

Port4

Pin4

RWr 2 Reserved

Bit Bit_15 Bit_14 Bit_13 Bit_12 Bit_11 Bit_10 Bit_9 Bit_8

Pin - - - - - - - -

RWr 3（Power Supply Diagnosis）

When there is an abnormality in the power supply of the module, according to the fault status of overvoltage

and undervoltage of the voltage value, the corresponding point indication is 1, otherwise the point is 0.

RWr 3 Power Supply Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Pin Ua_H
High

voltage

Ua_L
Low

voltage

Us_H
High

voltage

Us_L
Low

voltage

Ua_S
Short
circuit

- - -

RWr 3 Reserved

Bit Bit_15 Bit_14 Bit_13 Bit_12 Bit_11 Bit_10 Bit_9 Bit_8

Pin - - - - - - - -

6.3 Setting parameters of the module

Users can set module parameters in programming software. For example, in GX Works3, enter the "CC-Link IEF Basic
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Configuration" interface, select the corresponding module "Parameter Processing of Slave" option, and in the newly opened

window, users can modify module parameters as needed.

6.3.1 Process Data Layout

This parameter is used to set the address mapping order of the I/O module switch input and output signals. The default value is

0, which is arranged by port; It can also be set to 1, which is arranged according to the pins.

0-Port based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port0 Pin4 Port0 Pin4

1 Port0 Pin2 Port0 Pin2

……

6 Port3 Pin4 Port3 Pin4

7 Port3 Pin2 Port3 Pin2

X+1 0 Port4 Pin4 Port4 Pin4

1 Port4 Pin2 Port4 Pin2

……

6 Port7 Pin4 Port7 Pin4

7 Port7 Pin2 Port7 Pin2

1-Pin based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port0 Pin4 Port0 Pin4

1 Port1 Pin4 Port1 Pin4

……

6 Port6 Pin4 Port6 Pin4
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7 Port7 Pin4 Port7 Pin4

X+1 0 Port0 Pin2 Port0 Pin2

1 Port1 Pin2 Port1 Pin2

……

6 Port6 Pin2 Port6 Pin2

7 Port7 Pin2 Port7 Pin2

6.3.2 Port settings of the module

This section used to set the INPUT or OUTPUT function of the I/O module ports Pin4/Pin2.

For a detailed description of port settings, please refer to the following:

Item_1（Port Direction of Port 0~7）

This section is used to set the properties of Pin4/Pin2 in each port of the I/O module, which can be set as input or

output or universal.

The default is “Universal”, which means the Pin4/Pin2 can be used as input or output by wiring; Can be set to “Input”,

which means only as input; Can be set to “Output”, which means only as output.

6.3.3 Signal Filter Config

This section is used to set the filtering strength of the signal port. Depending on the setting value, the port will filter the input

switch signal. The smaller the value, the weaker the filtering strength; The larger the value, the stronger the filtering strength.

The default value is 2-medium.

0: extremely weak;

1: weak;

2: medium;

3: strong;

4: extremely strong
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6.4 Module configuration by MELSOFT (Mitsubishi PLC)

This section provides users with a comprehensive understanding of how to use the FCEN-16UP-M12-M module through a

practical operation process of configuring connections. In this case, with all power and bus connections completed, use

FCEN-16UP-M12-M as the CC Link IE Field Basic slave to connect the Mitsubishi controller FX5U, where the IP address of the I/O

module is specified as 192.168.3.11.

The following will show the specific process of software configuration and debugging.

1) Install CSPP configuration file for FCEN-16UP-M12-M module

A) Select "Tool" ->"Profile Management" ->"Register..." in the menu bar, and click to open a new window.

B) Select the version of the CSPP file to import and click “Register”.
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2) Create a new GX Works3 project

Open the MELSOFT software, click "Project>New...", select the PLC series "FX5CPU" and model "FX5U" in the pop-up

dialog box, choose the programming language according to your habits, and then click "OK" to create the project.
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3) After entering the interface, select the "Navigation" project tree on the left side, and then choose

"Parameter>Module Parameter>Ethernet Port" to enter the network settings interface.

4) In the newly opened window, set the IP address of the PLC to "192.168.3.250" and the subnet mask to

"255.255.255.0". Users can also set according to their own needs, please note that the PLC and module need to be on the same

IP network segment.
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5) Enable CC Link IE Field Basic network settings, click on the "To Use or Not to use CIB Setting" option, and select "Use"

to enable network settings.

6) Perform CC Link IE Field Basic network configuration settings.

A) Click the button on the right side of "Network Configuration Settings" or double-click the text to open the

"Detailed Setting" option.

B) In the newly opened "CC Link IE FB Configuration" window, click the "Detect Now" button to automatically scan

the FCEN module connected to the PLC, as shown in the figure.

C) Here you can see the IP address and other network information of FCEN-16UP-M12-M. Please confirm the

correspondence between the IP address and the module MAC address.
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D) Right click on the FCEN-16UP-M12-M module and select "Parameter Processing of Slave Station..." under the

"Online" option to enter the module parameter settings page.

E) In the newly opened parameter settings window, you can select "Parameter Read" and click the "Execute" button

to read the set parameters in modules that have already been connected to the network.
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F) If you want to change the module parameters, you can select "Parameter Write", click "Cancel All Selections" to

cancel all selections and check the parameters that need to be changed. After setting, click the "Execute" button to

write the module parameters that you want to change.

G) After setting up, click the "Close with Reflecting the Setting" button to save the content of network configuration

and close the interface.

7) Set up CC Link IE Field Basic network refresh and mapping.

A) Click the button to the right of “Refresh Settings” or double-click the text to open the “Detailed Setting” option.
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B) In the newly opened "Setting Item" interface, assign mapping addresses for RX, RY, RWr, and RWw in the PLC as

needed, and then click the "Apply" button as shown in the figure.

8) At this point, the network settings have been completed and the program can be downloaded to the PLC. Select

"Online>Write to PLC..." to open the download window, choose "Select All" and click the "Execute" button to execute the

download.

9) When the NET indicator light of FCEN-16UP-M12-M module is green and constantly on, it indicates that the

configuration is successful and the module has established communication connection with the PLC.
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7. Webserver

The FCEN-16UP-M12-M module integrates Webserver internally. Users can access the Webserver through the IP address, set

the parameters of the module, read and write input and output signals of the I/O module. (When the module is connected to

the PLC, the IO signals can only be read.)

In order to access the Webserver of the module, users need to first assign an IP address to the module. The method of assigning

an IP address can be referred by rotary switch or programming software. Then using the latest version of Chrome, Edge, or

Safari browser, enter http://xxx. xxx. xxx. xxx/webif/ to access the module. (xxx. xxx. xxx. xxx is the IP address assigned by the

module)

In this example, the IP of FCEN-16UP-M12-M module has been pre assigned to 192.168.0.15. Without connecting the PLC,

showing how to read and control signal points, upgrade module firmware programs, etc.

1) Set the IP address of the computer to 192.168.0.xxx on the same network segment as the FCEN-16UP-M12-M module.

Then open the browser and enter in the address bar http://192.168.0.15/webif/ . You can see the homepage of the module

Webserver.

http://192.168.0.15/webif
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2) Click on the “Process Data” project on the left to enter the signal point testing page. When the I/O is not connected to

the PLC, the input and output functions of the signal points can be tested through this interface.

3) To upgrade the firmware program of the module, click on the “Main-device” project under the “Upload” column to

enter the “Main Device Upload” interface. Click the “upload page” button to enter the “Firmware Upload” page.

4) On the “Firmware Upload” page, click the “Choose a firmware file to upload” button, select the firmware upgrade file
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“fwupdate.zip” and click OK.

5) After successfully selecting the upgrade file, you can see the file name to be upgraded. At this point, click the “Send file”

button, and the module will start upgrading the program. After about 15 seconds, you can see a prompt in the “Event Log”

on the right that the upgrade was successful, indicating that the upgrade was successful.

6) Click the “Reset” button and the module will restart, completing the entire upgrade process.
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8. Alarm diagnosis

8.1 LED fault indicator

With the LED indicator on the FCEN-16UP-M12-M module, users can easily and quickly determine the current working status of

the module. (For the appearance of the indicator, please refer to Section 2.2 "LED Indicator ")

Name Status Meaning Fault cause

I/O
channel
Indicator

A，B

Green Have signal –

Red
1. Short circuit

2. Output signal overload

1. Check the cable connection

2.Module channel is damaged

OFF No signal –

Module
status

Indicator
MOD

Green Work normally –

Red Working abnormally

1. Power supply is abnormal

2.Channel abnormal (short circuit, overload, etc.)

3. Module is damaged

Comm.
status

Indicator
NET

Green Communication normal –

Red Communication abnormal

1. Network cable failure

2. Check the configuration

3. Module is damaged

Network
status

Indicator
LK1, 2

Green
Network Cable connects

normal.
–

Off Network cable connects error.
1. Network cable failure

2. Module is damaged

Comm.
data

Indicator
ACT1, 2

Yellow flash Data exchange. -

Off No data exchange.
1. Check the configuration

2. Check the network hardware

Power
supply

Indicator
Us, Ua

Green Supply voltage normal –

Red Supply voltage abnormal
1. Over voltage or under voltage

2. Module is damaged

Off No power supply
1.Power supply cable failure

2. Module is damaged

8.2 EtherNet/IP address assignment

The default connection name for the FCEN-16UP-M12-M module is “I/O Connection Point”. This connection contains the input
and output signals and status of the I/O module. It contains 8 bytes of INPUT, 6 bytes of OUTPUT, and 34 bytes of CONFIG.
The table below lists the various data classifications, which can be found in Chapter 4 for details:
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INPUT Description

Byte 0…1 Input Signal Data of Port 0~7

Byte 2…3 Short Circuit Diagnosis of Port 0~7

Byte 4…5 Overload Diagnosis of Port 0~7

Byte 6 Power Supply Diagnosis

Byte 7 Reserved

OUTPUT Description

Byte 0…1 Output Signal Data of Port 0~7

Byte 2…3 Reserved

Byte 4 Reserved

Byte 5 Reserved

CONFIG Description

Byte 0 Process Data Layout

Byte 1…16 Pin4&Pin2 Type of Port 0~7

Byte 17…32 Pin4&Pin2 Safe State of Port 0~7

Byte 33 Signal Filter Setting

8.3 PROFINET address assignment

This section mainly introduces the signal point arrangement sequence and address allocation of FCEN-16UP-M12-M module,

mainly explaining the clear order of signals. This diagram shows the input/output signals and diagnostic status of the I/O

module. For details, please refer to Section 5.2:

8.4 CC-Link IE FB address assignment

This section mainly introduces the signal point arrangement order and address allocation of the FCEN-16UP-M12-M module,

which is used to clarify the signal arrangement order. This figure shows the occupancy information of software components in

the FCEN module:
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